
Description 

 1 

Mixed-Mode 
Delamination 
For software version:  23.0 
For software product(s):  Any Plus version. 
With product option(s): Nonlinear. 
Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 
This example demonstrates the use of delamination elements in a 2D analysis. Both 2D 
and 3D delamination elements are available within LUSAS. These elements have the 
ability to model all modes of crack growth under mixed-mode conditions - mode I 
(open) mode II (shear) and mode III (tear 3D only). 

 

The model is required to predict the growth of a crack within a unidirectional 
composite laminate subjected to mixed-mode loading. A starter crack 30 mm long is 
introduced at one end of a double cantilever beam (DCB) specimen. A tensile (crack 
opening) load is applied to the cracked end of the sample while a compressive (crack 
closing) load is applied to the centre of the specimen. The resulting delamination crack 
propagates along the length of the sample under mixed-mode conditions. 

The DCB specimen is constrained at either end and prescribed displacements are 
applied to the centre of the span in a negative Y direction and to the cracked arm, in a 
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positive Y direction. No axes of symmetry other than the plane strain assumption may 
be made. The geometry of the strip and support positions are as shown. 

Units of N, mm, t, s, C are used throughout. 

Objectives 
This analysis will: 

 Predict the initiation of delamination 
 Predict the propagation of a delamination crack with increasing displacement 
 Produce an animated Deformed Mesh Plot showing the growth of delamination  
 Produce a Contour Plot showing the redistribution of direct stress caused by 

delamination on the cracked Surface. 
 Produce an animated Yield Plot showing the behaviour of the interface during 

incrementation 
  
Keywords 
2D Inplane, Plane Strain, Delamination, Composite, Shell, Nonlinear, Yield 
Symbol, Contour Plot, Animation 

Associated Files 
Associated files can be downloaded from the user area of the LUSAS website. 

 delamination_modelling.lvb carries out the complete modelling of the 
example. 

Modelling : Delamination Model 

Running LUSAS Modeller 
For details of how to run LUSAS Modeller, see the heading Running LUSAS 
Modeller in the Introduction to LUSAS Worked Examples document. 

Note. This example is written assuming a new LUSAS Modeller session has been 
started. If continuing from an existing Modeller session select the menu command 
File>New to start a new model file. Modeller will prompt for any unsaved data and 
display the New Model dialog. 

Creating a new model 
• Enter a file name of delamination 

• Use the Default user-defined working folder. 

• Ensure an Analysis type of Structural is set. 

 

 
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• Select an Analysis Category of 2D Inplane 

• Set Model units of N,mm,t,s,C 

• Ensure Timescale units are Seconds 

• Select a Startup template of 2D Plane Strain  

• Ensure the Layout grid is set as None 

• Enter a Title of Delamination Model 

• Click the OK button. 

The Attributes  treeview will be populated with potentially useful basic line mesh, 
geometric and support entries appropriate to the settings made on the new model 
dialog. 

Note. It is useful to save the model regularly as the example progresses. Use the 
Undo button to correct any mistakes made since the last save was done. 

• Select the Meshing tab and set the default number of divisions to 2 

• Select the Options tab, select Element Options and select the option for Fine 
integration for stiffness and mass 

• Click the OK button to set the element options and the OK button to set the model 
properties. 

Defining the Geometry 

 Enter coordinates of (0,0), (30,0), (50,0) and (100,0) and click OK to define the 
Points. 

• Use the Ctrl and A keys together to select the Points just defined.  

 This defines a series of straight Lines between the Points. 

 

• Select the whole model using the Ctrl + A keys together. 

 Ensure that the 
Translate option is selected 
and enter a value of 1.5 in 
the Y direction. 

• Click the OK button to finish. This generates the first half of the model.  

 
 File 

Model Properties… 

Geometry 
Point > 

By Coords... 

Geometry 
Line > 

By Points... 

Geometry 
Surface > 

By Sweeping… 
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The second half of the model will now be created by copying the existing data and 
specifying a suitable gap to enable the interface elements to be embedded in the model. 
Once the interface elements have been assigned, this gap will be closed. 

• Select the whole model using the Ctrl + A keys. 

 Ensure that the Translate option is selected and enter a value of 20 in the Y 
direction. 
 
Note. At this stage the two halves of the model are separated to simplify the 
definition of the delamination interface elements. 

Meshing 
Delamination modelling requires a fine mesh density. The mesh density is controlled 
using Line mesh attributes. 

• Select Plane strain, Quadrilateral, Quadratic elements. Ensure the Regular 
mesh option is selected with automatic divisions so that Modeller uses the default 
number of mesh divisions on each line. 

• Give the attribute the name Plane Strain QPN8 

• Click the OK button to add the attribute to the  Treeview. 

• Select the whole model using the Ctrl + A keys. 

• Drag and drop the Plane Strain QPN8 attribute from the  Treeview onto the 
selected features. 

The  Treeview contains some commonly used line meshes. Null line meshes with 10 
and 30 divisions need to be added to those present. 

• With the Element description set to None define a line mesh attribute containing 10 
divisions and named Null, div = 10 

• Click the Apply button to add the attribute to the  Treeview. 

• Edit the number of divisions to be 30 and change the attribute name to Null, div = 
30 

• Click the OK button to add the attribute to the  Treeview. 

Geometry 
Surface > 

Copy… 

 

Attributes 
Mesh > 

Surface… 

Attributes 
Mesh > 

Line… 
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1. Assign Divisions=10
to these Lines 2. Assign Divisions=30 to these Lines

 

• Assign the Divisions=10 attribute to the horizontal lines on the left-hand section of 
the model. 

• Assign the Divisions = 30 attribute to the remaining horizontal lines of the rest of 
the model to give a mesh arrangement as shown. 

 

Geometric Properties 
Because this model is using plane strain elements there is no need to define or assign a 
geometric thickness to the model. Plain strain elements assume infinite thickness. 

Interface Elements 
• On the Line Mesh dialog define a line mesh for an Interface (plane strain) element 

type, of Quadratic order for assignment Between two features with 30 divisions.  

• Name the dataset Interface mesh  

• Click OK to add the dataset to the  Treeview. 

• Select the two horizontal lines on the right-hand side of the upper face of the 
bottom set of surfaces as shown in the following diagram. 

Attributes 
Mesh > 

Line… 
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1. Select these lines and
add to selection memory

 

This adds these two lines to Selection Memory. These will form the secondary surfaces 
of the interface elements. 

 

Note. Items can also be added to selection memory by using the right-hand mouse 
button in the display area and selecting the Selection Memory>Set menu entry from 
the popup menu, or pressing Ctrl + M. 

Note. The order in which the lines are selected is important. The interface elements 
are drawn between sequential pairs of lines in the two selections, i.e. the first set will be 
drawn between the first line in the selection memory and the first line in the selection.  

• Click in a blank area to deselect the initial selection (note that the lines in selection 
memory will remain highlighted) 

2. Select these lines

 

• Select the two horizontal lines on the right-hand side of the lower face of the top set 
of surfaces as shown in the previous diagram. Ensure the lines in the selection 
match those in selection memory as described in the note above. 

• Drag and drop the Interface mesh attribute onto the model. Ensure Mesh from 
primary to secondary is selected. Click OK to finish the assignment. 

Edit 
Selection Memory > 

Set 

 

 
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This clears the selection memory. 

 

Note. It is only necessary to make use of Selection Memory if assignment of the 
interface mesh is to be carried out on more than one line in one operation. By selecting 
a lower primary line, holding the Shift key down, and selecting the corresponding 
upper secondary line the assignment could also be carried out on a line by line basis. 

Composite Material 

LUSAS provides a number of the more common types of composite material in the 
Composite Material Library. In this example the component is fabricated from a 
unidirectional High Strength Carbon fibre reinforced polymer matrix composite. 

• Select HS Carbon UD Vf=60% from the drop down box. 

• With the Composite properties option selected, choose Plane Strain and click the 
OK button to add the properties to the  Treeview.  

The composite material is to be assigned to the surfaces of the model. Firstly check the 
surface axes to show the directions for the orthogonal material. 

• In the  Treeview click the right-hand mouse button on the Geometry layer and 
select Properties 

• On the dialog select the Surface Axes option and click the OK button. All surfaces 
should appear with the double arrow (X direction) horizontal. 

Note. If required the Surface > Reverse, Cycle and Cycle Relative tools can be used 
to re-orientate surface axes as desired. 

• Deselect the display of Surface axes as described above. 

Now assign the material properties: 

• Select the whole model using the Ctrl + A keys. 

Edit 
Selection Memory > 

Clear 

 
 

Attributes 
Material > 

Composite 
Library…  

 
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• Select the Orth3 (HS Carbon UD Vf=60% Plane Strain) attribute from the  
Treeview and drag and drop it onto the model.  

• Ensure the Assign to surfaces option is selected for Analysis 1 and click OK 

Interface Material 

Information concerning the fracture energies and the initiation stresses for the relevant 
failure modes are defined to describe the behaviour of the interface delamination 
model. For this example it is assumed that the interface characteristics are similar for 
the two modes, with mode 1 representing opening and mode 2 shear. 

• Select the Delamination Interface option and click Next. 

• Enter the value 4 for the fracture energy and 57 for the initiation stress for Mode 1 
and Mode 2. 

• Name the attribute Interface Material and click Finish to add the attribute to the 
Treeview. 

Note.  The interface material attribute need only be assigned to the primary features. 

• Click the right-hand mouse button on the Interface Mesh attribute in the  
Treeview and choose the Select Primary Assignments option from the drop down 
menu. 

• Drag and drop the Interface Material attribute from the  Treeview onto the 
model to assign to Lines. Click OK to assign the material 

Supports 
LUSAS provides the more common types of support by default. These can be seen in 
the  Treeview. The model will be supported in the Y direction at the cracked (left-
hand) end and in the X and Y directions at the uncracked (right-hand) end. 

 

• Select the point at the bottom left-hand corner of the model, drag and drop the 
support attribute Fixed in Y onto the selection and click OK to assign to Points. 

Attributes 
Material > 

Specialised > 
Interface… 

 



Modelling : Delamination Model 

 9 

• Select the point at the bottom right-hand corner of the model, drag and drop the 
support attribute Fixed in XY onto the selection and click OK to assign to Points. 

The supports will be visualised as shown. 

Loading  
The model is subjected to two prescribed displacements.  The left-hand (cracked) end 
of the model has a crack opening load assigned to it. A crack closing load is assigned to 
the mid-span. 

The structural Loading attributes dialog will be displayed. 

• With the Concentrated option selected click Next 

• On the Concentrated dialog enter a Concentrated load in Y Dir of 0.2125  

• Enter the attribute name as Opening 

• Click the Apply button to add the attribute to the  Treeview. 

• Edit the value in the Y direction to be -0.7125 

• Enter the attribute name as Closing 

• Click the Finish button to add the loading attribute to the  Treeview. 

Now assign the loads to the model. 

• With reference to the following diagram, select the uppermost Point in the top left-
hand corner of the model. 

Select this upper Point to assign Closing load
Select this upper Point to assign Opening load

 

• Drag and drop the loading attribute Opening from the  Treeview onto the 
selected Point. 

Attributes 
Loading… 
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• Click the OK button to accept the default Loadcase 1 and assign the loading to the 
model. 

• With reference to the previous diagram, select the uppermost Point in the middle of 
the top section of the model. 

• Drag and drop the loading dataset Closing from the  Treeview onto the selected 
Point. 

• Click the OK button to accept the default Loadcase 1 and assign the loading to the 
model. 

The loading will be visualised. 

Final Geometry Manipulation 
It is significantly easier to assign the appropriate mesh and the material properties of 
the interface region to the model if the interface surfaces are apart. Once these 
manipulations are complete it only remains to close the interface to complete the 
construction of the model. 

• Select the top section of the model. 

Drag a box to select the top section of the model

 

This makes the points of the upper section unmergeable, ensuring that the nodes either 
side of the embedded crack in the model are not merged together. Note that making 
points unmergeable will also ensure that the lines are also unmergeable. 

 

Geometry 
Point > 

Make 
Unmergeable 
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 Move the selection to join the bottom half of the model by selecting the Translate 
option, enter a value of -18.5 in the Y direction and click OK to confirm. 

Analysis Control 
Since this is a nonlinear problem the load incrementation strategy needs to be defined. 
The analysis is to be terminated when the vertical displacement at the left-hand tip of 
the specimen reaches 6mm. 

• Select the point at the top-left of the model where the opening load is applied. 

• From the  Treeview expand Analysis 1, click the right hand mouse button on 
Loadcase 1, then select Nonlinear & Transient from the Controls menu. 

The Nonlinear & Transient dialog will be displayed. 

• Select the Nonlinear 
option. 

• Set Incrementation to 
Automatic 

• Set the Starting load 
factor to 10. This will 
multiply the applied 
loading by a factor of 10 
on the first load 
increment. 

• To enable the load to 
increase as required set 
the Max total load factor 
to 0 

• To prevent the analysis 
carrying on too long if an error has been made set the maximum number of time 
step or increments to 50 

• In the Incremental LUSAS file output section set the Plot file value to 3. This will 
ensure results are output to the Modeller plot file every third load increment. 

• In the Incrementation section on the top-left of the dialog select the Advanced 
button. 

Geometry 
Point > 

Move... 
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• Ensure that incrementation by arc-length control is Always on 

• Select the calculation option Use root with lowest residual norm 

• In the Termination criteria section select the Terminate on value of limiting 
variable option. The point at the top left-hand corner of the model should be 
entered in the drop down list. Note that this may not be the same point number as 
shown in this dialog. 

• To stop the analysis once a displacement of 6mm has been reached at that point, 
select the Variable type as V and the value as 6 

• In the Step reduction section of the form ensure the Allow step reduction option is 
selected and set the Load reduction factor to 0.75 

• Click the OK button to return to the control dialog. 

• Click the OK button to exit the Nonlinear & Transient dialog. 

A  Nonlinear and Transient entry will be added to the  Treeview . A separate  
Nonlinear analysis options entry will also be added to the loadcase. 

Saving the model 
The model is now complete, and the model data must be saved. 

 Save the model file.  

 

Running the Analysis 
With the model loaded: 

File 
Save 
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 Open the Solve Now dialog and press OK to run the analysis. 

Note.  In running this nonlinear analysis a number of load increments are evaluated. 
On modern personal computers this will take just a minute or so. An indication of the 
time remaining can be obtained by observing the number of the increment being 
evaluated. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 
uses this datafile to perform the analysis. 

If the analysis is successful... 
Analysis loadcase results will be added to the  Treeview.  

In addition, these files will be created in the LUSASFiles\<model_name> folder: 

 delamination.out  this output file contains details of model data, assigned 
attributes and selected statistics of the analysis. 

 delamination.mys  this is the LUSAS results file which is loaded 
automatically into the  Treeview to allow results processing to take place. 

 

If the analysis fails... 
If the analysis fails, information relating to the nature of the error encountered can be 
written to an output file in addition to the text output window.  Any errors listed in the 
text output window should be corrected in LUSAS Modeller before saving the model 
and re-running the analysis.  

Rebuilding a Model  
If it proves impossible for you to correct the errors reported a file is provided to enable 
you to re-create the model from scratch and run an analysis successfully. You may 
download this file from the user area of the LUSAS website. 

 delamination_modelling.lvb carries out the complete modelling of the 
example. 

 

 Start a new model file. If an existing model is open Modeller will prompt for 
unsaved data to be saved before opening the new file. 

• Enter the file name as delamination 

• Use the default User-defined working folder. 

• Ensure an Analysis category of 2D Inplane is set. 

 

 

 
File 

New… 
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• Click the OK button. 

Note. There is no need to enter any other new model details when a script is run to 
build a model, since the contents of the script will overwrite any other settings made. 

 To recreate the model, select the file delamination_modelling.lvb that was 
downloaded and placed in a folder of your choosing. 

 Rerun the analysis to generate the results. 

Viewing the Results 
Analyis loadcase results will be present in the  Treeview. For a nonlinear analysis 
the last solved loadcase increment is set active by default.  

The first stage in any results processing is to examine the deformed mesh. 

Plotting the deformed mesh 
The outline of the crack which has been initiated and grown during the solution with 
load incrementation may be observed using a solid representation of the model. For this 
the deformed mesh will be examined alone. All of the model information currently 
displayed must be removed. 

With the last (lowest) available loadcase from the  Treeview set active:  

• If the deformed mesh is not already visible, with no features selected click the right-
hand mouse button in a blank part of the view area and select Deformed Mesh and 
press OK 

• Turn off each of the layer entries under the  Treeview except Deformed Mesh 

• Press the Deformations button at the bottom of the  Treeview, and then select 
the Specify Factor option and enter a value of 1. Press OK 

• Double click on the Deformed Mesh entry in the  Treeview and select the Mesh 
tab. 

• Ensure the Solid option and Outline only options are selected. 

• Click the OK button to add the deformed mesh layer to the  Treeview. 

Note. It is useful to use a magnification factor for displaying the deformed mesh for 
nonlinear analyses so that change in shape through the analyses can be observed. 

 
File 

Script > 
Run Script... 

 
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The deformed mesh plot for the final loadcase increment will be displayed. 

Plotting the load deflection graph 
• Select the node at the upper top left of the model where the opening load is 

applied. 

• With Time history selected click Next 

• With the Nodal option selected click Next 

• Select Entity Displacement with Component RSLT 

• The selected node will be visible in the drop down box. Click Next 

• Select the Named option and click Next 

• From the drop down list pick Total load factor and click Next 

• Enter the desired graph titles and click Finish to display the load deflection graph. 

 

• Close the graph window. 

Utilities 
Graph Wizard… 
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Stress contours  
The growth of the delamination seen in the deformed mesh affects the stress 
distribution within the structure. This stress redistribution is easily visualised using 
stress contour plots.  

With the last (lowest) available loadcase from the  Treeview still set active:  

• With no features selected click the right-hand mouse button in a blank part of the 
View area and select Contours to add the Contours layer to the  Treeview. 

The Contour Properties dialog will be displayed. 

• Select Stress - Plane Strain contour results in the direction SX 

• Click the OK button to finish.  

 

The contour plot and the associated contour key will be displayed. 

Animating the effect of delamination growth 
By setting other loadcase attributes active the effect of the delamination growth on the 
stress distribution may be observed. The most effective way to view this effect is to 
animate the deformed mesh with the stress contours layer showing.  

Before animating each loadcase the contour range must be set to avoid the contour key 
changing between animation frames. 

• Double click on the Contours layer in the  Treeview. 

• Select the Appearance tab. 

• For the Classic contour type, press the Set button and set the Maximum and 
Minimum values to be 1000 and -1000 respectively. 

• Select the Set as global range option 

• Click the OK button to finish.  

To create the animation: Tools 
Animation Wizard... 



Viewing the Results 

 17 

• Select Load History 

• Select Next 

• Select the All Loadcases option. 

• Select Finish to display the animated sequence. 

Note. Animations may be saved for replay using other Windows animation players 
using the File>Save As AVI menu option. 

 After viewing the animation close the animation window. 

Yield Plot 
The interface material formulation is an energy based model. The model allows the 
material to display three zones of behaviour. These are the elastic, softening and failed 
regions. Yield flags may be used to indicate which nodes within the model (if any) lie 
within a particular region. This technique allows a precise demonstration of the 
delamination crack extent within the model. 

• Turn off the Contours layer in the  Treeview. 

• With no features selected, click the right hand mouse button in the view window 
and select the Values layer from the menu. 

• In the Properties dialogue box select the entity as Stress - 2D Interface and the 
component Yield 

• Click OK to display the softening zone. 

 

The extent of the delamination for the current loadcase can be clearly seen. The 
delamination growth can be visualised by animating this plot through successive 
loadcases.  

 
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Animating delamination growth with yield flags 
To create an animation of the delamination growth with yield flags:. 

• Select Load History 

• Select Next 

• Select the All Loadcases option. 

• Select Finish 

 

This completes the example. 

 

 

 

 

 

 

Tools 
Animation Wizard... 


	Mixed-Mode Delamination
	Description
	Objectives
	Keywords
	Associated Files

	Modelling : Delamination Model
	Running LUSAS Modeller
	Creating a new model
	Defining the Geometry
	Meshing
	Geometric Properties
	Interface Elements
	Supports
	Loading
	Final Geometry Manipulation
	Analysis Control
	Saving the model

	Running the Analysis
	If the analysis is successful...
	If the analysis fails...
	Rebuilding a Model

	Viewing the Results
	Plotting the deformed mesh
	Plotting the load deflection graph
	Stress contours
	Animating the effect of delamination growth
	Yield Plot
	Animating delamination growth with yield flags



